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Abstract
	What is new?
	In a sentence or two, explain the need for this paper. What is the problem? Why is it original?

	What was the approach?
	How was the research undertaken? What methodology/methods were used? What data/sample/sources/literature was used? 

	What is the academic impact?
	What were the findings? Why are they significant? What does your paper contribute to the field of Research Management and Administration studies?

	What is the wider impact?
	What at the implication for research and management practitioners?

	Keywords
	List three or more keywords here.


Using this File to Format your Paper 
If is recommend that you use Word and this format when writing your document. If you do not use Word, details about the formatting guidelines are below. 
Different versions of Word have different ways of saving these formatting styles on your computer.  First, open this document on your computer.
· If you are using Word 2010, select the Home tab, click on Change Styles and then Style Set. Scroll to the bottom of the list of styles and select Save as Quick Style Set. Save these styles as a Quick Style Set giving it a meaningful name.
· If you are using Word 2016, select the Design tab and click on the pull down arrow at the right of the display of designs. Select Save as New Style Set. Save this style set, giving it a meaningful name.
To attach the styles to a blank document or one that you have already created, do the following. Open the document. 
· If you are using Word 2010, select the Home tab, click on Change Styles and then Style Set. The name you gave the style set should appear in the list. Click on it to attach it to your file.
· If you are using Word 2016, select the Design tab and click on the pull down arrow at the right of the display of designs. The Style Set you saved should appear under Custom. Click on the name to attach it to your document.
If you don’t want to save the styles, save this document under a new name. Delete from the top of page 2 to the end. You will have the correct formatting for the first page and the paragraphs, as well as the paragraph styles and can copy and paste your paper into it. 
General Information
Prepare your manuscript in Microsoft Word or export it from a different word processor into RTF format, following the specifications that we show here.
For papers that deal with data analysis, make the data available to readers via a link you place in your paper to a website where you store your data, if at all possible. Datasets with DOIs are preferred. We can help.
When you submit your paper for review, make sure that you have anonymised your paper by removing all references to yourself or your institution. Make sure these are removed from the document properties as well. To have your paper reviewed, you need first to submit a clean version (without author or affiliation information) that can undergo anonymous review. After your paper is accepted, you be asked to add the author information.
Language and Grammar Consistency
We publish papers written in English. If you have questions on English grammar or punctuation, search the web for guidance. You can find excellent guides at http://www.grammarbook.com and http://grammar.ccc.commnet.edu/grammar 
We accept all versions of English as long as they are used consistently throughout the paper.
Content
First Page Layout
To put the first page of your document in the proper format, copy the content of the first page from this file into your document and fill in the abstract information.
Author information (added after paper has been accepted)
Once the Editor has accepted your paper, insert the full name, the affiliation (University or Company), City, Country, ORCID iD, and email address for each author into the table on the first page. Insert additional rows if there are more than two authors. If there is more than one author, place an asterisk after the corresponding author’s name.
Also include a short biography for each author at the end of the paper.  Where there is more than one author the CRediT (Contributor Role Taxonomy, see: http://credit.niso.org/) should be used to indicate which of the tasks were performed by which author.  You may also indicate CRediT roles for single-authored pieces.
What to put in the abstract 
The abstract is a brief summary of the contents of the article; it should give enough information to make the reader want to learn more about your research, but it needs to be concise. In each of the boxes on the first page, enter one or two brief sentences appropriate for your paper. Omit citations from the abstract; citations for the paper’s sources do appear in the body of the paper.
Body of Paper
Introduction or background
All papers should begin with an introduction that sets the stage for the discussion. For some disciplines, it is more appropriate to use Background as an alternative first section.
Body
The body is a collection of multiple sections describing the main content of the paper. You should use up to three levels of headings to categorize content as deemed necessary: Heading 1, Heading 2, and Heading 3.
Conclusion
This section summarizes the paper, presents challenges, suggests future study, and so on to create a lasting impression of the paper.
Acknowledgments
Please list, where appropriate, any acknowledments including any details of funding or other relevant support.
Appendix
If there is an appendix, place it after the References and before the Biography. If there is more than one appendix, add a letter after “Appendix.”
If you have used a questionnaire in a study, include a copy of it as an appendix or provide a link to an external site with DOI.
References
Following the conclusion is a list of all references used in the body of the paper. Authors are permitted to use any referencing style as long as this is consistent.
We recommend using MLA 8 guidelines for internal citations within the body and to provide the complete alphabetic list of reference citations at the end of the paper. The References list contains only works cited in the paper and all works cited in the paper must be listed in the References section. 
Biography(ies)
After the paper is accepted, for each author of the paper, please provide a one or two paragraph biography that describes the author’s background relevant to this article. ORCID iDs should be included for each auhor. If there is more than one author then CRediT should be used to indicate the contributions that each author made (see: http://credit.niso.org/).
Page Formatting
To make it easier to read the paper online, use single column formatting for the paper.
Page Size
Set the paper size to A4, which is 21cm by 29.7cm.
Margins
Select Normal Margins. All margins, top, bottom, inside and outside, should be 2.54cm.
Headers and Footers
Insert page numbers in the footer. We will add the remaining information for the headers, and footers. 
Hyphenation
Do not hyphenate the text in the document. To turn hyphenation off:
· Select Language on the Layout or Page Layout menu.
· Select Hyphenation.
· Check None.
Footnotes
Footnotes should not be used at all. Insert your note within the body of the paper (if it is important) or omit it. The editors will remove footnotes and place the material within the text. 
Paragraph Styles (This is a Heading 1 Style)
If you have not attached these styles to your paper, use Word’s default paragraph styles for your document, making just the changes indicated below. 
Headings (This is a Heading 2 Style)
Do not number headings. Enter the headings with no outline numbers or letters in front of them. 
Paper Title 
Use the Paper Title style for the title of your paper. It is centered with a border under it. The font for this style is Nirmala UI Semilight, 20 point, Bold, and Small Caps.
The paragraph formatting is Centered with a 6 point space after it and an underline border at the bottom. The “Keep with Next” property is selected.
Capitalize the first letter of every major word. Do not use all upper case.
First level headings
Use the Heading 1 style for the title and for major headings. The font for this style is Nirmala UI Semilight, 16 point, Bold, and Small Caps. 
The paragraph formatting has a 3 point space before and a 6 point space after it and an underline border at the bottom. The “Keep with Next” property is selected.
Capitalize the first letter of every major word. Do not use all upper case.
Second level headings
Use the Heading 2 style for second level headings. The font for this heading is Nirmala UI Semilight, 14 point, Bold, Italic and Small Caps. The space before the paragraph is 12 point and the space after is 3 point. The “Keep with Next” property is selected.
Capitalize the first letter of every major word in second level headings. Do not use all upper case.
Third level headings (This is a heading 3 style)
Use the Heading 3 style for third level headings. The font for this heading is Nirmala UI Semilight, 12 point, Bold. The space before the paragraph is 12 point and the space after is 3 point. The “Keep with Next” property is selected. 
Capitalize only the first word and proper nouns in this heading.
Text Paragraphs
Use the Normal style for paragraphs of text. The paragraph is single-spaced with no indentation and has a 6-point space after it. The font for this style is 12 point Nirmala UI Semilight. Do not put blank lines between paragraphs.
Other types text of paragraphs
Fourth level. Three levels of headings are enough for most papers. If you need another level, such as for this paragraph, use the Normal style and place the heading at the beginning of the paragraph in bold font.
Lists. Use Word’s automatic bullet or number formats for lists.
References: Use a 11 point Nirmala UI Semilight font with a hanging indent of 0.25 inches (0.635cm).
Other. Use other formats only when absolutely necessary.
Figures and Tables
A table is data presented in tabular format with rows and columns. A figure is any other pictorial representation of data such as graphs or drawings. Each figure or table must be numbered and have a brief caption that describes it. Every figure or table must be referenced in the body of the paper. Table 1 is an example of a table and Figure 1 is an example of a figure.
Table 1. Example of a table
	ID#
	LAST
	FIRST
	CATALOG #
	CATEGORY
	QUANTITY
	AMOUNT
	COMMISSION

	S00001
	Golden
	Rod
	M00002
	Multiple
	2
	$250.00
	$12.50

	S00001
	Golden
	Rod
	M00012
	Hiking
	1
	$50.00
	$2.50

	S00001
	Golden
	Rod
	M00028
	Multiple
	1
	$95.00
	$4.75

	S00002
	Red
	Rose
	M00038
	Multiple
	1
	$35.00
	$1.92
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Figure 1. Example of a figure
The caption for tables is placed above the table; the caption for figures is placed below the figure.
All accepted papers need to be reformatted before publication; therefore, it is important that all figures and tables can be easily resized and/or moved. Since tables and figures may be moved during the final formatting, do not use “above” or “following” when referring to them; just give the table or figure number. Also, do not use automatic numbering of tables and figures as these can become corrupted when figures or tables have to be rearranged. Tables and figures may be inserted directly into the paper or placed on separate pages at the end of the paper.
There are two ways to submit figures.
1. insert the figure, formatted as a picture that can be resized. It is best if it is inserted directly into the paper with “in line” wrapping.
2. send figures as PowerPoint slides in a separate file and, within the paper, indicate where they are to appear,
Do not send figures formatted as separate text boxes or groups of images on the page. 
Copyright and Creative Common Licence
We will publish your paper under a Creative Commons Attribution 4.0 International License (CC BY-NC 4.0) and the author(s) retain the copyright.
By submitting the paper, as author(s) you certify the following:
1. You hold copyright for this submission, and
2. You warrant that you have not infringed on any copyright and assume full liability in case of copyright dispute.
Copyright Issues for Figures
There are three common sources of figures. 
1. Figures you have copied from another source, including a web site. You must contact the holder of the copyright for the image and get permission to use it. Cite the source and add “used with permission.”
2. Figures that you create based on another’s work. You do not need to get permission but include in the citation “adapted from” or “based on” and give the source.
3. Figures that are your original work. Since you hold the copyright for these, there are no copyright issues.
Entering References
Any referencing style can be used. Accuracy and consistency is the responsibility of the author. We recommend MLA 8, but this isn’t a requirement.
List the sources alphabetically at the end of the paper under “References” using a Heading 1 style. Place entries in alphabetical order according to the last name of the first author. Within the text of your paper, cite sources by placing the author’s last name, date and page number in parentheses.
[bookmark: _Hlk35950041]DOIs and URLs in Reference list. When citing sources from the Web, include the year of publication or the most recent update. End the entry with a DOI if it has one. If it does not have a DOI, end the entry with the URL. Do not end the path statement or a DOI with a period. DOIs can be found by going to https://search.crossref.org/references and entering the reference entry. DOIs begin with https://doi.org/ followed by numbers and letters that identify the document, for example, https://doi.org/10.18552/jorma.v4i1.1251
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(Leave this blank when submitting for review.)
Include one or two short paragraphs about each author. 
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